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Introduction

Introduction

This chapter provides information on the purpose of the manual, safety information, and addi-
tional documents and resources.
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Purpose

Purpose

The Class 6 SmartMotor™ Installation & Startup Guide provides an overview of the Class 6
SmartMotor, along with information on unpacking, installation and start up. This guide is
meant to be used in conjunction with the SmartMotor Developer's Guide, which describes the
SmartMotor features, SMI software, programming, commands, and other topics related to
SmartMotor application development.

The information in this guide is meant to be used by properly trained technical personnel only.
Moog Animatics conducts classroom-style SmartMotor training several times per year, as well
as product seminars and other training opportunities. For more information, please see the
Moog Animatics website or contact your Moog Animatics representative.

Safety Information

This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of the following safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard,
where failure to follow the instructions could result in serious injury to the

operator or major damage to the equipment.

CAUTION: This symbol indicates a potential minor hazard, where failure to fol-
low the instructions could result in slight injury to the operator or minor dam-

age to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to
cover all the safety standards and considerations that are part of the overall machine/system
design and manufacturing safety. Therefore, the following information is intended to be used
only as a general guideline for the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assess-
ment" and to ensure that the machine/system and its safeguards comply with the safety stand-
ards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the locale
where the machine is being installed and operated. For more details, see Machine Safety on
page 7.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are prop-
erly sized for the specific application. Undersized motors may: perform poorly, cause excess-
ive downtime or cause unsafe operating conditions by not being able to handle the loads
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Environmental Considerations

placed on them. The Moog Animatics Product Catalog, contains information and equations that
can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the
approved and validated system. Specification changes or firmware upgrades require the
approval of the system designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating
environment for dust, high-humidity or presence of water (for example, a food-processing
environment that requires water or steam wash down of equipment), corrosives or chemicals
that may come in contact with the machine, etc. Moog Animatics manufactures specialized IP-
rated motors for operating in extreme conditions. For details, see the Moog Animatics Product
Catalog.

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the
machine/system builder must perform a "Risk Assessment", which is often based on the ISO
13849 standard. The design/implementation of barriers, emergency stop (E-stop) mech-
anisms and other safeguards will be driven by the Risk Assessment and the safety standards
specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the locale where
the machine is being installed and operated. The methodology and details of such an assess-
ment are beyond the scope of this manual. However, there are various sources of Risk Assess-
ment information available in print and on the internet.

NOTE: The following list is an example of items that would be evaluated when per-
forming the Risk Assessment. Additional items may be required. The safeguards
must ensure the safety of all personnel who may come in contact with or be in the
vicinity of the machine.

In general, the machine/system safeguards must:

« Provide a barrier to prevent unauthorized entry or access to the machine or system. The
barrier must be designed so that personnel cannot reach into any identified danger
zones.

« Position the control panel so that it is outside the barrier area but located for an unres-
tricted view of the moving mechanism. The control panel must include an E-stop mech-
anism. Buttons that start the machine must be protected from accidental activation.

« Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

« Provide appropriate sensors and interlocks on gates or other points of entry into the pro-
tected zone that will stop all machine movement when tripped.

« Ensure that if a portable control/programming device is supplied (for example, a hand-
held operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional
system design considerations and safeguards beyond those listed in this sec-
tion. For details, see the safety standards specified by the governing author-
ity (for example, ISO, OSHA, UL, etc.) for the locale where the machine is
being installed and operated.
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Documentation and Training

« Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys,
tooling, etc.).

« Prevent contact with a part that is thrown from the machine tooling or other part-hand-
ling equipment.

« Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other
hazards that may be present at the machine.

» Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

« Provide a proper control system, program logic and error checking to ensure the safety
of all personnel and equipment (for example, to prevent a run-away condition). The con-
trol system must be designed so that it does not automatically restart the machine/sys-
tem after a power failure.

« Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety,
operation, maintenance and programming, along with training for all machine operators, main-
tenance technicians, programmers, and other personnel who may have access to the

machine. This documentation must include proper lockout/tagout procedures for maintenance
and programming operations.

It is the responsibility of the operating company to ensure that:

« All operators, maintenance technicians, programmers and other personnel are tested
and qualified before acquiring access to the machine or system.

« The above personnel perform their assigned functions in a responsible and safe manner
to comply with the procedures in the supplied documentation and the company safety
practices.

« The equipment is maintained as described in the documentation and training supplied by
the machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the
need for additional equipment. In general, it is the responsibility of the operating company to
ensure that:

« Unauthorized access to the machine is prevented at all times.

» The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear,
smocks or aprons, gloves, hard hats and other protective gear.

« The work area is equipped with proper safety equipment such as first aid equipment,
fire suppression equipment, emergency eye wash and full-body wash stations, etc.

« There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.
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Safety Information Resources

Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open
the file "109_Controls, Warnings and Cautions.pdf" located at:

http://www.animatics.com/support/moog-animatics-catalog.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://www.ul.com/global/eng/pages/solutions/standards/accessstandards/
catalogofstandards/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/enterprise/policies/european-standards/harmonised-standards/
index_en.htm
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Additional Documents

Additional Documents

The Moog Animatics website contains additional documents that are related to the information
in this manual. Please refer to the following list:

o SmartMotor™ Developer's Guide

http://www.animatics.com/support/download-center.html

e SmartMotor™ Product Certificate of Conformance

http://www.animatics.com/download/Animatics_SmartMotor_Servida_Class_5_Declar-
ation_of Conformity CE_Rev_1.pdf

o SmartMotor™ UL Certification

http://www.animatics.com/download/MA_UL online_listing.pdf

o SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port
Status, Serial Port Status, RMODE Decoder and Syntax Error Codes)

http://www.animatics.com/support/download-center.html

« Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources

The Moog Animatics website contains additional resources such as product information, doc-
umentation, product support and more. Please refer to the following list:

« General company information:

http://www.animatics.com

o Product information:

http://www.animatics.com/products.html

« Product support (Downloads, How To videos, Forums, Knowledge Base, and FAQs):

http://www.animatics.com/support.html

« Sales and distributor information:

http://www.animatics.com/sales-offices.html

« Application ideas (including videos and sample programs):

http://www.animatics.com/applications.html
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Additional Resources

EtherCAT is a common standard maintained by EtherCAT Technology Group (ETG):
« EtherCAT Technology Group website:
http://www.ethercat.org

PROFINET is a common standard maintained by PROFIBUS & PROFINET International (PI):
o PROFIBUS & PROFINET International website:

http://www.profinet.com
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SmartMotor Overview

SmartMotor Overview

This chapter provides an overview of the design philosophy and functionality of the Moog Anim-
atics SmartMotor. It also provides information on SmartMotor features and options, and
where to find related documents and additional resources.

SmartMotor Introduction ... 14
SmartMotor Features and Options ... ... . 15
Class 6 M-Style MOTOrS ... 15
Fieldbus OptioNs ... L 17
EtherCAT Fieldbus Protocol . ... . 17
PROFINET Fieldbus Protocol ... . . 17
SmartMotor Theory of Operation ... ... . 18
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SmartMotor Introduction

SmartMotor Introduction

The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller
integrated into a compact package. Its design is based on the following objectives:

1. Reduce development time
2. Lower machine-production cost

3. Simplify the machine, machine build and support

Class 6 M-Style SmartMotor

The SmartMotor is powerful and unique because of its ability to control an entire machine. The
combination of programmability, networking, I/O and servo performance is unmatched. The
SmartMotor brings savings and value to the machine builder by removing complex and costly
elements in the machine design, such as PLCs, sensors, I/0 blocks, cabinets, etc.
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SmartMotor Features and Options

SmartMotor Features and Options

All SmartMotors offer the following features:

Full floating-point math and trigonometric functions with 32-bit precision results

Dual trajectory generators enabling relative and absolute position moves or velocity
moves on top of gearing or camming

Advanced gearing allowing preset traverse and take-up winding parameters including
dwells and wrap counts

Advanced camming including cubic spline interpolation and dynamic frequency and amp-
litude changes.

Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

Virtual-axis mastering into camming through gearing, which enables stand-alone,
multi-axis coordinated motion

Programmable and non-programmable protection features (both hardware and soft-
ware)

A note about SmartMotor part numbers:

The SmartMotor uses a coded part humber, which contains characters that describe the motor
number, frame style and options. For details on decoding the SmartMotor part number, refer
the Moog Animatics Product Catalog at this address:

http://www.animatics.com/support/moog-animatics-catalog.html

and select the file: 14_Understanding Part Numbers.pdf.

Class 6 M-Style Motors

The Class 6 SmartMotor is available in an M-style configuration. All Class 6 M-style SmartMo-
tors have:

SmartMotor command access through RS-485 or USB
Ports: Two industrial Ethernet (IE) ports for real-time daisy chain

LEDs: Bi-colored LED indicators to show error codes, provide network status and com-
munications activity

Communications: RS-485, micro USB, and industrial Ethernet
SMI software: Used for application development and debug
Motor feedback: Supported

Motor sample rate: 16 kHz

Encoder: 4000 counts per revolution

Position Capture Register from signal-ended, ground-referenced external input (non-dif-
ferential)

External Encoder input: Differential A-quad-B

A or B channel input frequency up to 100 kHz
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Class 6 M-Style Motors

For a product-specific list of features, specifications, torque curves and more, see the cor-
responding SmartMotor datasheet for your motor. SmartMotor datasheets are available from
the Products menu on the Moog Animatics website.

The following industrial (Fieldbus protocol) communications options are available on the Class
6 motors. (Availability varies by model number; see the Moog Animatics Product Catalog for
details.)

« EtherCAT option
o PROFINET option
All firmware options include:
« Modbus Remote Terminal Unit (RTU) Slave (RS-485 COM 0)
The M-style motors are available in the following NEMA frame sizes:
« NEMA 23

The following figure shows the connector and LED location for the Class 6 M-style SmartMotor.
For details on the motor connectors, see Connecting the System on page 30. For details on the
LED functions, see Understanding the Status LEDs on page 37.

Micro USB

USB Active LED

1/0 Communication

Industrial Ethernet

s

LED 4: Link LED /¢ \ LED 5: Link LED

LED 2: (Network specific*¥) / \ LED 3: (Network specific**)
LED 0: Motor Drive LED LED 1: Motor Busy LED

‘4

Power Input

**Refer to the Status LED description in the corresponding SmartMotor fieldbus guide

Class 6 M-Style SmartMotor Connectors and LEDs

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you
must connect the OUT port (right-hand port) of the upstream motor to the IN

port (left-hand port) of the downstream motor.
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Fieldbus Options

Fieldbus Options

This section details the Fieldbus communications protocol options that are available on certain
models of SmartMotors.

EtherCAT Fieldbus Protocol
NOTE: This fieldbus protocol is optionally available on Class 6 M-style motors.
The EtherCAT fieldbus protocol provides the following features:
« Command/Response Codes for SmartMotor commands

« CiA 402 Motion Modes: Profile Position (PP), Profile Velocity (PV), Torque (TQ), Cyclic
Sync Position (CSP), Cyclic Sync Velocity (CSV), Cyclic Sync Torque (CST)

« Dynamic PDO mapping

» Configurable Sync Manager 2 and 3 assignment

« DC-Sync Subordinate Mode with SYNCO and SYNC1

« DC-Sync Slave

« Selectable Homing modes (with or without index pulse)

« Selectable Interpolation modes (spline or linear)

« Touch Probe function allows the motor's position to be captured on a specific event

For the EtherCAT connector diagram and pinouts, see Connecting the System on page 30.

For more details on the EtherCAT protocol implementation, see the SmartMotor EtherCAT
Guide.

PROFINET Fieldbus Protocol
NOTE: This fieldbus protocol is optionally available on Class 6 M-style motors.
The PROFINET fieldbus protocol provides the following features:
« Command/Response Codes for SmartMotor commands
« Use of on-board I/0 through PROFINET, SmartMotor program, or RS-485 commands

« The Moog Animatics communications profile over PROFINET is intended to integrate well
with a PLC that continuously transmits and receives cyclic data; the command and
response codes achieve this through a handshaking mechanism

» Certain configuration data is held in nonvolatile storage in the SmartMotor; therefore,
the motor data EEPROM must be correctly initialized before PROFINET operation

For the PROFINET connector diagram and pinouts, see Connecting the System on page 30.

For more details on the PROFINET protocol implementation, see the Class 6 SmartMotor™
PROFINET Guide.
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SmartMotor Theory of Operation

SmartMotor Theory of Operation

The Moog Animatics SmartMotor is an entire servo control system built inside of a servo
motor. It includes a controller, an amplifier and an encoder. All that is required for it to oper-
ate is power and either an internal program or serial commands from outside (or both). To
make the SmartMotor move, the program or serial host must set a mode of operation, state a
target position with/or a maximum velocity at which to travel to that target, and a maximum
acceleration. After these three parameters are set, and the two limit inputs are properly
grounded or deactivated, a "Go" command starts the motion profile.

The core functional areas of the SmartMotor are:

« Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

» System Control Functions (see Program Flow Details in the SmartMotor™ Developer's
Guide, also see System Status in the SmartMotor™ Developer's Guide)

« Communication Functions (see Communication Details in the SmartMotor™ Developer's
Guide)

« I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The following block diagram illustrates the relationship between the functional areas in the

SmartMotor.
VI= AT= DI= G, X, OFF, S .
PT= PRT= ADT= MTB !
l : Control
. ‘/f‘\ Vel J* KV : on’off Not supported on
Trajectory1 /M pyo KA : D-series motors
14 ccel % |
mp | mv | mp ! [K11] [xP1]
}
I ! Torque
— [P lexrp N command
Traiectory 2 RPC S 7 g
jectory HD——O L= Kixedt KL !
mC | MFR | MsR - !
RPA filter - !
KS D |kD* 5 :
1 Current
Cam + Sensors
function' ® Motor
— PWM
l g g Encoder
External RCTR(0) N Hall sensor
Encoder {
Follow mﬁ g Commutation
9]
Profile |N¥i &
M
Internal 4 SRC(2)
Clock: SRC(1)
1 tick per SRC(0) —
PID cycle [ -1} — SRC(-1) —
|' % -1 |' SRC(-2) —o
NOTES:

1. MFMUL and MFDIV commands do not have an effect on dwell time or distance. Dwell is strictly based on raw master encoder counts selected by the

SRC() command specifying internal virtual or external master count source.
2. When feeding a Cam table with a gearing profile, changes to MFMUL and MFDIV will affect the time it takes to move through a Cam table but will not
affect dwell time, as specified in the previous note.

SmartMotor Theory of Operation Diagram
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Getting Started

Getting Started

This chapter provides information on getting started with your SmartMotor.
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Getting Started

Using the Detect Motors Feature ... L 41
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Polling the MOtOr .. . 44
Clearing the Overtravel Limits and Fault Bits ... . ... .. ... 45
Moving the SmartMotor il 46
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment

Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected
and packed at the factory.

When you receive your shipment, you should immediately do the following:

« Visually inspect all shipping containers for visible signs of shipping damage. If you see
damage, please notify your carrier and then contact Moog Animatics to report the prob-
lem.

« Carefully unpack each component and verify the part number with your order. If there
are any differences or missing items, please contact Moog Animatics so that the ship-
ment can be corrected.

» As you are unpacking the shipment, please keep all boxes and packing materials. These
may be needed for future storage or shipment of the equipment.

Installing the SMI Software

The SmartMotor Interface software (SMI software) provides a convenient user interface for
programming the SmartMotor. Before you can use the SMI software, it must be installed on a
Microsoft Windows PC.

The SMI software is distributed on CD-ROM and is also available as a download from the Moog
Animatics website. To download the latest version of the SMI software, use the following
address:

http://www.animatics.com

Then click the SMI Download button at the top of the page.

[ SMi- cowniond | Gl e AN | Lo

NMOOG

==+ ANIMATICS L

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure

To install the SMI software:

1. Double-click the executable package (.MSI) file to begin the installation. In some ver-
sions of Microsoft Windows, you may receive a security warning message about running
the file. You can ignore this message.

If this is a new installation, go to the next step.
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Installation Procedure

If this is an upgrade to a previous installation, you will see the following window. Select
Remove, click Next and follow the instructions to remove the existing software from

Application Maintenance
Select the maintenance operabon to perform

Version 24,32  (with IntegMotorinterface 2.2.1.1)

Change which applicabion features are nstalled. Displays the
Select Festuies dalog, which lels you configue indridual fealunes

Feinstall mizsing or coeupt fles, registn keps, and shorcuts
Praferences stored in the regestiy may be resat to defaul values.

ﬂ Urinztall Smarthator [nterface from this compuber,

Wise Installation Wizard (R)

After removing the existing software, restart the installation process.
NOTE: All personal settings and user files will be retained.

2. Click Next to proceed. The Installation Configuration page opens.

¥Yersion 24.32  (with IntegMotorinterface 2.2.1.1)

Select desired langusge. | English

"wiise Instalation \wWizad®
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome
page opens.

Welcome to the SmartMotor
Interface Installation Wizard

It iz shangh recommendsd thal vou exit 8l Windows progeams
be=fore running this setup program

Click Cancal bo quit the setup progranm, then chase anp programs
yous have wnning. Click Next bo cortinue the installstion.

WARNIMG: Thiz program i probected by copynght law and
nbeenational lieaties,

Unauthorized repeaduction oo distribution of this program, oo sy
portion of &, may result in severe cral and cimnal penales, and
will be prozeculed to the masimum extent possible under lew.

4. After you have finished reviewing the welcome information, click Next to proceed.
Continue following the on-screen instructions to complete the SMI software installation.

5. When the installation has completed, the installation status message page opens, as
shown in the following figure. Click Finish to complete the installation and close the
installation wizard.

SmartMotor Interface has been
successfully installed.

Click: the Finish butlon Lo el this installstion.

NOTE: After the software is installed, be sure to restart your computer before run-
ning the SMI software.
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Installation Verification

Installation Verification

To verify the installation, navigate to the C:\Programs folder. You should see the following dir-
ectory structure:

4  Animatics
» 0 SMIZ

Accessing the SMI Software Interface

The SmartMotor Interface software (SMI software) communicates with a single or series of
SmartMotors from a Windows-based PC and gives you the capability to control and monitor
the status of the motors. The SMI software also allows you to write programs and download
them into the SmartMotor’s long-term memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not
necessary to use the SMI software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows
desktop.

7

SmartMotor
Interface

SmartMotor Interface Shortcut

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:
Start > All Programs > Animatics > SMI2 > SmartMotor Interface

The SMI software interface opens, as shown in the following figure.

Moog Animatics Class 6 SmartMotor™ Installation & Startup Guide, Rev. 03 - PRELIMINARY
Page 26 of 58



Accessing the SMI Software Interface

Menu bar
Toolbar
Configuration
window

Terminal
window

Program
editor

Information
window

Com! | Etheinel | ISR | CAM CharrelD |
I Opsn [l Mofces L-Enhrn:l Por

Ethwmonmi
USE
AN Chaswl 0 125000 bgie)

Far Help, press FlL

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The following are the primary features in this interface:

Menu Bar: All of the windows and functions of the SMI software can be accessed through
the menu bar. Many of these are also accessible through the icons on the toolbar.

Toolbar: The toolbar contains a collection of icons for accessing the primary features of
the SMI software. Depending on the current state of the SMI software and the currently-
active window, some toolbar buttons may be disabled.

Configuration Window (far-left window): This window is used to display the current com-
munication and detected motor configuration when no project is open, or the com-
munication and motor configuration defined in an open project.

Terminal Window (middle window): This window is used to communicate with SmartMo-
tors (for example, issue single-line commands to one or all motors). The response (if
any) is also shown in this window.

Information Window (lower window): This window is used to display the results of user
operations.

Program Editor (far-right window): This window is used to manage, edit and print user
programs. Most of the procedures for using the editor should seem familiar if you have
used other Windows-based text editors.

For more details about these items, see SMI Software Features in the SmartMotor™
Developer's Guide.
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Understanding the Power Requirements

Understanding the Power Requirements

This section describes the power requirements for Class 6 M-style SmartMotor power,
CPU power, I/O power and Communications power.

Power Requirements
Requirement:

For Class 6 M-style SmartMotors: control power requires nominal 24 VDC (£20%), do not
exceed 32 VDC; motor power requires from 24 VDC to 48 VDC, do not exceed 48 VDC.

CAUTION: Control power for M-style motors must be nominal 24 VDC
(£20%). They are not rated for 48 volts.

Details: Large SmartMotors can draw high current. Therefore, heavy gauge wire is required
to connect the large motors.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as
a power-off reset, under sudden load changes.

CAUTION: If power is reversed on any standard SmartMotors, immediate
damage WILL occur and the SmartMotor will no longer operate.

When relying on torque/speed curves, pay close attention to the voltage on which they are
based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of dam-
age if a shunt resistor pack is not used. Protective shunts are available from Moog Animatics.

Special care must be taken when near the upper voltage limit or in vertical applications that
can back-drive the SmartMotor. Gravity-influenced applications can turn the SmartMotor into
a generator and back-drive the power supply voltage above the safe limit for the SmartMotor.
Many vertical applications require a shunt to protect the SmartMotor from damage. Protective
shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast decel-
erations require shunts to protect the SmartMotor from damage. Note that
shunts should always be placed between the motor input and any disconnect or

E-stop relay to protect the motor when power is off or E-stop relay contacts
are open.

CPU, I/0 and Communications Power

CAUTION: The maximum allowed supply voltage is 32 VDC. Voltages greater
than the maximum value will damage the equipment.
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CPU Power Requirements

CPU Power Requirements

Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input con-
nector.

I/0 Power Requirements
Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input con-
nector.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.

24 VDC Control/IO output power is provided on pin 11 and supports a maximum of 2 amps.
That pin is directly connected to Pin 1 of the power input connector. Refer to Motor Connectors
and Pinouts on page 31.

Specifications:

NOTE: All specifications assume nominal 24 VDC (£20%) Control power. The max-
imum allowed supply voltage is 32 VDC. Voltages greater than the maximum value
will damage the motor.

Input Pins Electrical Specification:

« Input Voltage Low Level Threshold: 3.6 Volts maximum
« Input Voltage High Level Threshold: 5.0 Volts minimum
« Input Hysteresis Voltage: 1.0 Volts minimum

Output Pins Electrical Specification:

o Output Loading:

« Nominal load: 250 mA each output

« Maximum load: not to exceed 500 mA combined
« Output voltage: 23 Volts maximum load

Communications Power Requirements

Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input con-
nector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor
drive.

Drive Enable Power

The Drive Enable input must be connected and activated with 24V. For the input location, see
Motor Connectors and Pinouts on page 31.
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Connecting the System

Connecting the System

The following sections show system connections and cable diagrams for typical installations.

Minimum Requirements
At minimum, you will need the following items:

1. A Class 6 M-style SmartMotor

2. A computer running Microsoft Windows and the SMI software
3. A DC power supply and power cable for the SmartMotor
4

. A data cable to connect from the computer to the SmartMotor using one of the fol-
lowing:

« Serial port (or serial adapter)
« USB port
« Ethernet port

Refer to the following sections for more details.
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Motor Connectors and Pinouts

Motor Connectors and Pinouts

The following figure provides an overview of the connectors and pinouts available on the Class
6 SmartMotors. Additional connector specifications are available in Class 6 M-Style Connector
Pinouts on page 56.

1/Os
PIN | FUNCTION INPUT OR OUTPUT POSSIBLE (SELECTABLE) FUNCTIONS DESCRIPTION
1 [ INO PUT, DIGITAL OR ANALOG | GENERAL PURPOSE GENERAL PURPOSE
2 | IN1 PUT, DIGITAL OR ANALOG | GENERAL PURPOSE GENERAL PURPOSE
3 | IN2/POSLIMIT PUT, DIGITAL OR ANALOG | POSITIVE LIMIT OR GENERAL PURPOSE POSITIVE LIMIT
4 | IN3/NEGLIMIT [ INPUT, DIGITAL OR ANALOG | NEGATIVE LIMIT OR GENERAL PURPOSE NEGATIVE LIMIT
5 | IN4 INPUT, DIGITAL OR ANALOG | GENERAL PURPOSE, OR EXTERNAL ENCODER GENERAL PURPOSE
INDEX CAPTURE
6 | IN5 INPUT, DIGITAL OR ANALOG | GENERAL PURPOSE, OR INTERNAL ENCODER | GENERAL PURPOSE
INDEX CAPTURE
7 |IN6g INPUT, DIGITAL OR ANALOG | GENERAL PURPOSE, G COMMAND, OR GENERAL PURPOSE
HOMING INPUT
8 | IN7-DRVEN INPUT, DIGITAL DRIVE ENABLE DRIVE ENABLE
9 | OUT8/BRAKE OUTPUT, DIGITAL BRAKE OUTPUT OR GENERAL-PURPOSE OUTPUT| BRAKE OUTPUT
10 [ OUT9-NOFAULT | OUTPUT, DIGITAL NOT FAULT NOT FAULT
11 | 24 VDC OUT* N/A N/A CONTROL/IO POWER
12 | GND N/A N/A MOTOR COMMON GROUND

*NOTE: 2 AMPS MAX.

INDUSTRIAL ETHERNET OPTION:

EtherCAT* PROFINET
PIN | FUNCTION PIN | FUNCTION
4 USB Active LED COMMUNICATION
T | +IX 1| +D 3
2 | +RX 2 | +RD 1 PIN | FUNCTION
3 | X 3 |-1D
T | GND-COMMON
4 | RX 4 | RD e 2 | RS-485B CHO
3 | RS-485A CHO
4 | ENC A+ IN
5 | ENC B- 1
6 | ENC A- IN
7 | 5VDC OuT
8 | ENC B+ IN

w

LED 4: Link LED LED 5: Link LED

LED 2: (Network specific**) LED LED 3: (Network specific**) LED

LED 0: Motor Drive LED LED 1: Motor Busy LED

POWER INPUT
PIN | FUNCTION | DESCRIPTION
1 |1 24VDC Control/IO Power
2 | EARTH Chassis Ground
3 | GND Motor's common ground
4 | 48 VDC Motor Power

*The Input/Output applies to these networks. Refer to the following CAUTIONS.
**For LED Status information, refer to the corresponding SmartMotor fieldbus guide.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you
must connect the Output port (right-hand port) of the upstream motor to the
Input port (left-hand port) of the downstream motor. For more details, see
Industrial Ethernet Cable Diagram on page 34.
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Power and RS-485 Com Multidrop

Power and RS-485 Com Multidrop
RS232485T

ﬁ -I CBLIP-COM-FL (8 Pin)
i | CBLIP-COM-Y1-xM

24V Control Power
24V - 48V Drive Power

NOTE: RS-485 serial communications uses a voltage differential signal that
requires proper termination with a 120 ohm resistor across pins 2 and 3 at both
ends of the network cable. This follows RS-485 standards for biasing to ensure reli-
able performance. The termination can be created by adding the resistor to CBLIP-
COM-FL Flying Lead cables or to off-the-shelf connectors.

USB Connector and Cable

As shown in following figure, there is a micro USB (micro-B) connector located under a pro-
tective cover on top of the motor. An LED indicator is also provided, which shows the

status/activity for that connector.
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USB Connector and Cable

Micro USB

Micro USB Connector (Located Under Protective Cover)

NOTE: To keep dust and debris out of the port, always replace the protective cover
when the micro USB connector is not in use.

A micro-B USB cable is a standard type of USB cable that can be obtained from most com-
puter or electronics supply stores. Typically, this cable is referred to as a "micro USB" cable.

Micro USB Cable

NOTE: Be aware that some micro USB cables have a thicker plastic molding that
may interfere with the motor housing.
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Industrial Ethernet Cable Diagram

The following figure shows the SmartMotor connected to a PC through the USB ports on both
devices.

USB connection from
PC to SmartMotor

USB Connection from PC to SmartMotor

Industrial Ethernet Cable Diagram

Most industrial Ethernet (IE) networks support line, tree or star device-connection topology.
Requirements for specific configurations depend on the capabilities of the master device, the
slave devices, and use of other networking equipment. For more details, refer to the cor-
responding SmartMotor fieldbus manual.

CAUTION: To minimize the possibility of electromagnetic interference (EMI),
all connections should use shielded Ethernet Category 5 (Cat 5), or better,

cables.

The following diagram shows an example industrial Ethernet network with the SmartMotors
daisy chained to the master device. An optional "ring" configuration can be created if the mas-
ter device has two ports.
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Maximum Cable Length

Industrial Ethernet Network

Optional ring for cable redundancy*

*¥ *¥ *¥ *¥
Master device: [ ] ) IO_U_Tl [ ] - IO_U.Tl Other slave device:
-PC, Moog Animatics Moog Animatics - 1/0 block,
-PLC, SmartMotor SmartMotor - Servo drive,
- etc. - etc.

*Ring configuration requires a master device with two ports
**The Input/Output applies only to EtherCAT networks. Refer to the following CAUTION.

NOTE: Unlike other fieldbus protocols, EtherCAT does not require terminators at
each end of the network bus.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you
must connect the OUT port (right-hand port) of the upstream motor to the IN

port (left-hand port) of the downstream motor.

Maximum Cable Length

For transmission speeds of 100 Megabits/second on shielded Ethernet Cat 5 cable, most indus-
trial Ethernet networks allow cable lengths up to 100 meters between network nodes. For
more details, refer to the corresponding SmartMotor fieldbus manual.

Moog Animatics Industrial Ethernet Cables

The following industrial Ethernet cables are available from Moog Animatics.

M-style to M-style Ethernet Cable

This cable has M12 male threaded connectors at both ends. It is availablein 1, 3, 5and 10
meter lengths. For the standard cable, use part number CBLIP-ETH-MM-xM, where "x"
denotes the cable length. A right-angle version is also available; use part number
CBLIP-ETH-MM-xMRA.

3
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M-style to RJ45 Ethernet Cable

M-style to RJ45 Ethernet Cable

This cable has an M12 male threaded connector at one end, and an RJ45 male connector at the
opposite end. It is available in 1, 3, 5 and 10 meter lengths. For the standard cable, use part
number CBLIP-ETH-MR-xM, where "x" denotes the cable length. A right-angle version is also
available; use part number CBLIP-ETH-MR-xMRA.

 e— 11

Ethernet Cable Schematic

The following figure provides details for creating a custom industrial Ethernet shielded cable.

NOTE: The motor end of the cable requires an industrial Ethernet connector.

)
(1] )/ |
\X
RJ45 Connector Industrial Ethernet Connector
(EtherCAT master end of cable) (Motor end of cable)

SHIELD

12345678
PIN | DESCRIPTION PIN \ DESCRIPTION
1 +TX 1 | +TX
2 |-TX 2 | +RX
3 |+RX 3 |-TX
4 No Connection 4 |-RX
5 | No Connection Shield tied to motor housing
6 |-RX
7 No Connection
8 No Connection
S

hield tied to RJ45 connector
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Understanding the Status LEDs

Understanding the Status LEDs

This section describes the functionality of the status LEDs on the Class 6 SmartMotor.

Status LEDs

The following figure and tables describe the functionality of the Status LEDs on the SmartMo-

tor. Refer to the corresponding SmartMotor fieldbus guide for the functions of the network-spe-

cific LEDs.

LED 4: Link LED
LED 2: (Network specific) LED
LED 0: Motor Drive LED N

USB Active LED

LED 5: Link LED
LED 3: (Network specific) LED
LED 1: Motor Busy LED

Flickering = On/Off in 0.1 sec; Blinking = On/Off in 0.5 sec; Flashing = separated by 1 sec for EtherCAT LEDs and 2 sec for Fault Codes

LED 0: Motor Drive LED
Off No power

Solid green Drive on

Blinking green  Drive off, no faults

Triple red flash ~ Watchdog fault

Solid red Faulted or no drive enable input

LED 2: (Network specific) LED
Refer to the corresponding SmartMotor
fieldbus guide

LED 4: Link LED
Refer to the corresponding SmartMotor
fieldbus guide

LED Status on Power-up:
» With no program and the travel limit inputs are low:
LED 0 solid red; motor is in fault state due to travel limit fault

LED 1 off

» With no program and the travel limits are high:
LED 0 solid red for 500 milliseconds then flashing green

LED 1 off

« With a program that only disables travel limits:
LED 0 red for 500 milliseconds then flashing green
LED 1 off

USB Active LED

Flashing green  Active
Flashing red Suspended
Solid red USB power detected, no
configuration
LED 1: Motor Busy LED
Off Not busy
Solid green Drive on, trajectory in progress

Flashing # red

Flashes fault code* (see below)
when Drive LED is solid red

LED 3: (Network specific) LED
Refer to the corresponding SmartMotor

fieldbus guide
LED 5: Link LED

Refer to the corresponding SmartMotor

fieldbus guide

LED 1 Fault Codes:
Flash Description
NOT Used
Bus Voltage
Over Current

Velocity Limit

©CoONOOOrWN =

Excessive Temperature
Excessive Position

dE/Dt - First derivative of position error is excessive
Hardware Positive Limit Reached
Hardware Negative Limit Reached

10 Software Positive Travel Limit Reached
11 Software Negative Travel Limit Reached
*Busy LED pauses for 2 seconds before flashing the code

Moog Animatics Class 6 SmartMotor™ Installation & Startup Guide, Rev. 03 - PRELIMINARY
Page 37 of 58




Detecting and Communicating with the SmartMotors

Detecting and Communicating with the
SmartMotors

This section describes how to detect and address the Class 6 SmartMotors over the serial net-
work.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 30.

- The SmartMotor is connected to a power source. For details, see Understanding the
Power Requirements on page 28 and Connecting the System on page 30.

« The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 23.

Understanding the Detection and Configuration Options

There are several ways to use the SMI software to find and address the Class 6 SmartMotors
that are connected to your PC:

NOTE: This feature requires connection to the serial port, configured as RS-485.
USB also has a "detect" option. There is no support for EtherCAT or PROFINET detec-
tion.

« Use the Find Motors button (RS-485 only)—this method is recommended for first-time
communications or when you don't know the port used to connect the motors. For
details, see Using the Find Motors Button on page 38.

« Use the Detect Motors feature (RS-485 and USB only)—this method can be used if you
know the communications port used to connect your motors and if your motors may be
pre-addressed. For details, see Using the Detect Motors Feature on page 41.

« Configure and communicate with PROFINET or EtherCAT—this method allows you to con-
figure the motor to work in an industrial Ethernet (PROFINET or EtherCAT) network. For
details, see the corresponding fieldbus protocol guide.

Several of these methods are described in the following sections.

Using the Find Motors Button
NOTE: This method works only for RS-485 connections.

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the
following figure). This method searches the RS-485 port(s) on the PC for connected motors.

To begin searching for motors on the RS-485 port(s) on the PC, in the Configuration window of
the SMI software interface, click Find Motors. The SMI software begins searching for all
SmartMotors connected to the PC.
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Using the Find Motors Button

Fle  Edit View  Communication Compale  Tools Window Help
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CAN Channel 01 25000 bps)
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Find Motors Detecting SmartMotors on the RS-485 Chain

After the motors are detected, the SMI software will address them if needed. The following
steps are only used when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see the following prompt.

Sl iz about to try and address the motors, This will issue an END command causing
. the rurning program to stop exscution. Do you wish SMI o continue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software
addresses the motors. During this process, the SMI software is collecting the following inform-
ation on each motor. The information is the same as that shown in the Motor View window,
which can be accessed by selecting the Tools > Motor View > Info tab:
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Using the Find Motors Button

B Motor View - "Motorl-Coml”

25|

Status || | Mu:unitu:url Uzer ‘Jarial:ulesl Flags I Ealculatiunsl Trace I

Mator Mame: IMDtDﬂ -Comn1
Mator Address: |1
Yerzion: IE.EI.'I.F"
Serisl Number: |E138285
Model: |5M23216MH-NEI

S ample Period: IEI.EIEEEEIEI m3ec.
Program Mame: I_E_N_D_.sm:-:
Download Time: IDE;"EIB.-’:ZEI'I 4105234 [mdddy himes]
Program Size: IES Bytes

Ship D ate: ||:|3.-"1 B/2012
Firrnware D ate: IDEC 132013111407

PROFIMET Mame: ISMEEDEUW

Scaling:
Mo zcale iz defined faor thiz motor, To define scale, click the "Edit
Froperties" button,

Display ADEB Save ADEB

Detailz Edit Fropertiez et Info

Motor View Information

After the process has completed, the SMI software shows the found motors in the Con-
figuration window under the corresponding communications port. Each motor is represented
by a motor icon; the motor's address and firmware version are shown next to the motor icon.

Find Matars |

Detected Configuration

..... Erne[
&g LUSE
----- CaM Channel 0 [128000 bps)

Configuration Window Showing Found/Addressed SmartMotor
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Using the Detect Motors Feature

Using the Detect Motors Feature
NOTE: This method works only for RS-485 and USB connections.

This method is similar to the Find Motors method, but it searches only the specified com-
munications port for connected SmartMotors. This is also the recommended method for detect-
ing M-style motors after they have been pre-addressed and daisy-chained to the
communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click
the desired communications port and select Detect Motors from the menu.

B oot icrec

File Edit View Communication Compile Teools Wi

D& Hd SiTig N

Fitd M otors | Com1 l Ethem
=-4&l Detected Configuration W Open  |Alll

- % Com1 (RS485-9500 bps) [

----- # Ethemnet
n Properties

I Detect USE Motars I

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified com-
munications port. A progress bar is shown while the SMI software searches for the motors.

After the motors are detected, the SMI software will address them if needed. The following
steps are only used when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see the following prompt.

Shdl iz about to fry and address the motars, This will izsue an EMD command cawsing
. the rurning program bo stop execution, Do you wish SMI to contirue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software
addresses the motors. During this process, the SMI software is collecting the following inform-
ation on each motor. The information is the same as that shown in the Motor View window,
which can be accessed by selecting the Tools > Motor View > Info tab:
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Using the Detect Motors Feature

B Motor View - “Motorl-USB" e |

....................

Statuz | Info | Mu:unitu:url Uzer ‘Jarial:ulesl Flags I Ealculatiunsl Trace I

Motar Mame: IMDtDH -USE
Mator Address: |1
Yerzion: IE.EI.'I.F"
Serisl Number: |E138285
Model: |5M23216MH-NEI

S ample Period: IEI.EIEEEEIEI m3ec.

Program Mame: I_E_N_D_.sm:-:

Download Time: IDE;"EIB.-’:ZEI'I 4105234 [mdddy himes]
Program Size: IES Bytes

Ship D ate: ||:|3.-"1 B/2012
Firrnware D ate: IDEC 132013111407
FROFINET Mame: |SMEEDE‘JEI1

Scaling:
Mo zcale iz defined faor thiz motor, To define scale, click the "Edit
Froperties" button,

Display ADEB Save ADEB

Detailz Edit Fropertiez et Info

Motor View Information

After the process has completed, the SMI software shows the found motors in the Con-
figuration window under the corresponding communications port. Each motor is represented
by a motor icon; the motor's address and firmware version are shown next to the motor icon.

Firnd bdotars |

ElE [Z_I__ete-::ted Configuration
ry Coml [R5485-3600 bpz)

----- & F et
- 5B

Configuration Window Showing Found/Addressed SmartMotor
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Checking and Clearing the Status Bits

Checking and Clearing the Status Bits

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in
conjunction with the Terminal window to clear any active overtravel limits.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 30.

« The SmartMotor is connected to a power source. For details, see Understanding the
Power Requirements on page 28 and Connecting the System on page 30.

» The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 23.

« The SmartMotor has been detected and addressed. For details, see Detecting and Com-
municating with the SmartMotors on page 38.
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Polling the Motor

Polling the Motor
To view the current state of the status bits, you must poll the motor.
1. Double-click the motor icon to open the Motor View window (see the following figure).

2. Click the Poll button to begin polling data from the motor.

B Motor View - "Ml::-tl::rl-Coml ﬁ
Statuz llnfu:- ] Mu:unitu:-r] | zer "v"arial:ulesl Flagz ] Ealculatiuns] Trace ]
FT s | o B
[ [ Hex Display 1

Position: 0 |Status Word O ﬂ
Pasz. Emar; I
Velozity: i 0 3 Drive ready

. 1 @ Bo: Motor is off
b ode: 0 . .

2 3 Bt Trajectary in progress

Mone :|v 3 (3 Bus vottage fault
Mone il 4 (3 Ba: Ower-current occurred

§ (3 Bh: Excessive temperature fault
Irput/Clutput: Fied 24v. Grey Ov £ (# Be: Excessive position errar

o1 2 3 4567 7 (3 By velocity limit
DO LQ & (3 Resltime temperature limit

g g 9 (3 defdt error limit

0D 10 @ Positive HW limit enabled
11 @ Hegative HW limit enabled
12 @ Br: Historical positive HW limit
13 @ BI: Historical negative HW limit
14 @ Bp: Positive HW limit asserted
15 @ Bm: Hegative HW limit asserted

Clear Flags [Z5] |

WVer: 6.0.1.7 Model: SM23216MH-NEI

e e ¥

Motor View with Active Overtravel Limits

A SmartMotor with no program and no I/0 connections will boot up with active overtravel lim-
its (see the red status bits numbered 10 through 15 in the previous figure).

The EIGN() command is used to clear these status bits as described in the next section. EIGN
stands for: Enable Inputs as General Use. In the case of EIGN(W,0), the W means a "word" or
16 bits of I/0; the 0 means first word or local I/0. There are only seven local I/O on the
D-style motors. Therefore, EIGN(W,0) sets all seven I/0 to general-use inputs.
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Clearing the Overtravel Limits and Fault Bits

Clearing the Overtravel Limits and Fault Bits

To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Ter-
minal window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit)
as general inputs/outputs instead of being used as travel limits. To set all status bits in Word O
as general inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the com-

mand directly in the blue area of the terminal screen and then click Send or press
Enter.

The active and asserted bits are cleared, as shown in the following figures.

Coml | Ethemet| USE | CAN Channel 0| 10 {2 Positive HAW limit enabled
¥ Open [AlMotors = ]|Coml,9600,S485,Chil BN 1162 Negative HIW limit enabled
| Sord 12 @ Br: H_IEtﬂr_ICﬂl pﬂsrtfve HW |I-I‘I"Il-t
4 13 @ Bl: Historical negative HVW limit
14 {3 Bp: Positive HAW limit asserted
15 {3 Bm: Megative HAY limit asserted

EIGN (W, 0}

EIGN Command Entered Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the
following figures.

Coml | Ethemet | USE | CAN Channel 0] 10 & Positive HAW limit enabled
V Oper [alMotors  ~|[Com1, 9600 R5485.ChiO BT 11 (& Negative HAW limit enabled

| Send 12 {3 Br: Historical positive HAW limit

. 13 {3 Bl Historical negative HAW limit
14 {3 Bp: Positive HAW limit asserted
15 {3 Bm: Megative HAY limit asserted

ZS Command Entered Remaining Bits Cleared

Moog Animatics Class 6 SmartMotor™ Installation & Startup Guide, Rev. 03 - PRELIMINARY
Page 45 of 58



Moving the SmartMotor

Moving the SmartMotor

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure
the drive is operating properly.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 30.

« The SmartMotor is connected to a power source. For details, see Understanding the
Power Requirements on page 28 and Connecting the System on page 30.

» The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 23.

« The SmartMotor has been detected and addressed. For details, see Detecting and Com-
municating with the SmartMotors on page 38.

« The Drive Enable input must be connected and activated with 24V. For the input loc-
ation, see Motor Connectors and Pinouts on page 31.

« The overtravel limits and fault bits have been cleared. For details, see Checking and
Clearing the Status Bits on page 43.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great

force. Therefore, proper motor restraints must be used, and safety pre-
cautions must be considered in the workcell design (see Other Safety Con-
siderations on page 6).

To make the SmartMotor move:

1. Inthe Terminal window, select the tab that matches the communications channel to
which your motors are connected. To do this, look at the Configuration window, find the
channel where the motors are listed and click that tab name in the Terminal window.

Find tataors

v Open  |ANE

o LUSE
- CAM Channel 0 [1258000 bpz]

Tab Selected that Matches the Communications Channel
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Setting and Reporting Torque

NOTE: If you do not have the correct tab selected, the commands you enter
will not go to the motors and there will be no response.

2. Enter the following commands in the Terminal window:
Coml | Ethemet | USE | CAN Channel 0]
W Open  |&liMotors o ||Com1,9600,RS485 Chi0 N1

| Send

MT

T=3000

G

You should immediately see the motor shaft moving in the positive direction (clockwise,
when looking at the end of the motor shaft). If the motor does not respond to the com-
mands, see Troubleshooting on page 54 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-
used commands. For details, see Macros in the SmartMotor™ Developer's
Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate
the motor to a stop.

Setting and Reporting Torque

The following commands are related to the previous motion procedure. For more details on
these commands, see the SmartMotor™ Command Reference Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a
torque independent of position. For more details, see Torque Mode in the SmartMotor™
Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM
(pulse-width modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory gen-
erator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous
example, T=3000, but RTRQ reports 2999. This is due to zero being counted as the least
amount of torque commanded. TRQ is always % PWM commanded to the motor at any time
and in any mode of operation. It can be used to transfer across modes without a ripple or
bump in force applied to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example
of the TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.
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Checking the Motor Position

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor
changes torque by a value of 1 for each PID sample. The default sample rate is 16000; you
can view the current sample rate with the RSAMP command.

NOTE: If you're moving from a Class 5 to a Class 6 SmartMotor, the faster Class 6
sample rate means the torque slope operates twice as fast in real-world time.

Checking the Motor Position

There are several ways to check the motor position:
« Report the position using commands from the Terminal window
» View the position in the Motor View tool

These two methods are described in the following sections. You can also view the position in
the Monitor or Chart View software tools. For details, see SMI Software Features in the
SmartMotor™ Developer's Guide.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 30.

« The SmartMotor is connected to a power source. For details, see Understanding the
Power Requirements on page 28 and Connecting the System on page 30.

« The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 23.

« The SmartMotor has been detected and addressed.

« The overtravel limits and fault bits have been cleared. For details, see Checking and
Clearing the Status Bits on page 43.

Viewing the Motor Position with a Report Command

To report the motor position, in the Terminal window, issue the RPA (Report Position Actual)
command:

RPA
The terminal responds with the current position of the motor:
RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line
feed or carriage return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued.
Therefore, it is just a "snapshot"—if the motor is moving, the reported position is not dynam-
ically updated.

Viewing the Motor Position with the Motor View Tool

The Motor View tool provides another way to view the motor position. The advantage of using
this tool is that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the
motor you want to view and select Motor View from the menu.

Configuration
Find Matars | Carn1 | Ethemetl JsE
EE Detected Configuration W Open I"ﬁ‘" batars
E(;yi Coml [R5485-9600 bps] I
rs 4 otor -Cornl (6.0.1.7]
b Ether Motor View
E%‘giﬂ ] Prv::u|:u=:r‘cin=:jh
P =l¢5f= CaM O Set Motor Address
Smarthator Playgraund

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information
from) the motor. After polling begins, the motor position is shown in the Position box.

# | Motor View - “Motorl-Coml w

Shatus [Intc | Monitor | User Variables | Flags | Calculations | Trace |
o _se | s |GENEE®  Ae
r I [ Hex Display 1
Positior: 30000 - Statuz Ward D =
Pos. Enar: 0
Velociy: o | 0@ Drive ready

Mode: Position 13 Bo: Motor is off

2 {J Bt: Trajectory in progress
None =] 33 Bus volage faul
Hane 'I 4 3 Ba Over-current occurred

5 {2 Bl Excessive temperature fault
~Input/Qutput — Fled 24v, Grey v =1 | 6 ) B Excessive postion error
01 2 3 458 B 7 70 By Velochy limit
QLOuULOLOO 8 Res-time temperature limdt
o® 10 & Positive HAW Emit enabled
11 {3 Negative HW limit enabled
12 Br: Historical positive HVW limit
13 {3 Bl Historical negative HAY it
14 ) Bp: Positive HAV limit asserted
153 Bm: Negative HAY lmit assered

Clear Flags 5] |

Ver: 6.0.1.7 Maodel: SM23216MH-NEI

Motor View Tool Showing the Motor Position
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Other Class 6 Changes

Other Class 6 Changes

In addition, please note the following items:

Features not Available in Class 6

The following Class 5 SmartMotor features have not yet been implemented in the Class 6
SmartMotors:

« Combitronic communications
o CAN communications

« CANopen protocol

» DeviceNet protocol

o I2C communications

« Synchronized motion

EOBK(exp) Command Limitations

The EOBK(exp) command configures the specified SmartMotor output to control an external
brake. However, only output 8 works for the M-style SmartMotor. Therefore, the valid EOBK
(exp) values are:

« EOBK(8) to enable
« EOBK(-1) to disable

Status Bit for Ethernet in Status Word 2

The intent of this bit is to inform the user that one or more errors has occurred through the Eth-
ernet interface. To determine the specific error that has occurred, consult the RETH com-
mand. For details, see the Class 6 SmartMotor™ EtherCAT Guide.

I/0 Control Details

The SmartMotor fieldbus guides describe the details of accessing I/O for each communication
protocol. The SmartMotor™ Developer's Guide describes I/0 control details for RS-485 com-
munications.

In a local program or serial command, the OR, OS and OUT commands are the same as Class
5. For details, see the SmartMotor™ Developer's Guide.

For the Class 6 M-style SmartMotor, it is important to note which are inputs, which are out-
puts, and which have special functions. For those details, refer to the following table.
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I/0 Control Examples

Logical Possible
I/0 Ig':llt"tl:’tr (Selectable) Default Operation
Number P Functions
0 IIQSUt only, digital or ana- General purpose General purpose
1 IIQSUt only, digital or ana- General purpose General purpose
5 Input only, digital or anaq Positive limit, or general Positive limit
log purpose
3 IInput only, digital or ana-4 Negative limit, or gen- Negative limit
og eral purpose
I | General purpose, or
4 IIQDUt only, digital or ana index capture for General purpose
9 external encoder
. | General purpose, or
5 IIQDUt only, digital or ana index capture for General purpose
9 internal encoder
6 Input only, digital or anaq General purpose, G com- | ~oneral purpose
log mand, or homing input
7 Input only, digital Drive enable Drive enable
8 Output only, digital Brake output or general- | 5 o output
purpose output
9 Output only, digital Not fault Not fault

I/0 Control Examples

To make output 8 a general-purpose output:

EOBK (1)
OR (8)
0S (8)
EOBK (8)

To read inputs:

x=IN(W,0,15)
EIGN (2)

EIGN (3)

EILP

RIN (3)

'Disables brake output from any I/0 pin

'Clears output
'Sets output
'Restores output 8 to

(0 volts)
(24 volts)

brake function

'Reads inputs 0,1,2,3 as bitfield stored into variable x
'Disables positive limit, makes a general-purpose input
'Disables negative limit, makes a general-purpose input
'Re-enables positive limit

'Reads input 3

Scale Factor Calculation — Sample Rates

The sample rate for Class 6 SmartMotors is fixed at 16,000 Hz (16 kHz).
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New Commands for Class 6

New Commands for Class 6

The following commands were added for the Class 6 SmartMotor:
NOTE: These commands are not available for the Class 5 SmartMotor.

IDENT=, RIDENT, x=IDENT: Set the IDENT value which is useful for user programs to
detect which axis they are. Report, use in expression, or assign the value of IDENT to a user
variable.

IPCTL(action,"string"): Sets IP address, Mask, or Gateway:
action= 0, set IP address; 1, set Mask; 2, set Gateway;
"string": formatted as an IP address and entered as a string;
e.g., IPCTL(0,"192.168.0.10") sets IP address to 192.168.0.10

PRINTO: Explicitly outputs to the COMO serial port.
PRINTS: Explicitly outputs to the USB port.
RSP5: Reports network interface card firmware version.

RUSB(arg), x=USB(arg): Report the value of the specified USB status word (specified by
arg) or assign it to a variable.

RUSB, x=USB: Report the value of USB status word 0 or assign it to a variable.

SNAME("string"): Sets a unique PROFINET station name. See the Class 6 SmartMotor™
PROFINET Guide.

For details on these commands, see the SmartMotor™ Developer's Guide.
The following industrial Ethernet (IE) commands were added for the Class 6 SmartMotor:
NOTE: These commands are not available for the Class 5 SmartMotor.

RETH(arg), x=ETH(arg): Assign result to a variable or report errors and certain status
information for the EtherCAT or PROFINET bus. See the corresponding fieldbus manual for arg
values.

ETHCTL(action,value): Controls network features. See the corresponding fieldbus manual
for details.

For details on these commands, see the Class 6 SmartMotor™ EtherCAT Guide or the Class 6
SmartMotor™ PROFINET Guide.

Commands That Have Changed

The following commands have been modified for the Class 6 SmartMotor:

PRINT: Follows the value of STDOUT, which is 8 (USB port) by default. Note that this beha-
vior is slightly different than the Class 5 version.

STDOUT=8: (Default) Sets internal report commands to the USB port.

For details on these commands, see the SmartMotor™ Developer's Guide.
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Commands Not Currently Supported

Commands Not Currently Supported

The following commands are not currently supported in the Class 6 SmartMotor:
CAN related: CADDR=, CANCTL, CBAUD=, RCADDR, RCAN, RCBAUD

Sync motion commands (require Combitronic): ADTS, ATS, DTS, GS, PRTS, PRTSS,
PTS, PTSS, RPTSD, RPTST, TSWAIT, VTS

Commands associated with the second serial port or other hardware that is not
available in the M-style motors: BAUD(1)=, CCHN on channel 1, ECHO1, ECHO_OFF1,
OCHN on channel 1, PRINT1, RBAUD(1), RGETCHR1, RLEN1, ROC, ROF, SILENT1, SLEEP1,
TALK1, WAKEL,

Other: ENCCTL, MDT, PID

For Further Information...

For further information on SMI software features, SmartMotor programming details, com-
munication details, motion details, a complete command reference and more, see the
SmartMotor™ Developer's Guide.
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Troubleshooting

Troubleshooting

The following table provides troubleshooting information for solving common problems. For
additional support resources, see the Moog Animatics Support page at:

http://www.animatics.com/support.html

Issue

Cause

Solution

Communication and Control Issues

Motor control power
light does not illu-
minate.

Control power is off, dis-
connected or incorrectly
wired.

Check that control power is connected to
the proper pins and turned on. For con-
nection details, see Connecting the Sys-
tem on page 30.

Motor does not com-
municate with SMI.

Transmit, receive or
ground pins are not con-
nected correctly.

Ensure that transmit, receive and ground
are all connected properly to the host PC.

Motor program is stuck
in a continuous loop or
is disabling com-
munications.

To prevent the program from running on
power up, use the Communications
Lockup Wizard located on the SMI soft-
ware Communications menu.

Motor disconnects
from SMI sporad-
ically.

COM port buffer settings

Adjust the COM port buffer settings to

are too high. their lowest values.
Poor connection on Check the serial cable connections and/or
serial cable. replace it.

Power supply unit (PSU)
brownout.

PSU may be too high-precision and/or
undersized for the application, which
causes it to brown-out during motion.
Make moves less aggressive, increase
PSU size or change to a linear unreg-
ulated power supply.

Motor stops com-
municating after
power reset, requires
re-detection.

Motor does not have its
address set in the user
program. NOTE: Serial
addresses are lost when
motor power is off or
reset.

Use the SADDR or ADDR= command
within the program to set the motor
address.

Red PWR SERVO light
illuminated.

Critical fault.

To discover the source of the fault, use
the Motor View tool located on the SMI
software Tools menu.

Common Faults

Bus voltage fault.

Bus voltage is either too
high or too low for oper-
ation.

Check servo bus voltage. If motor uses
the DE power option, ensure that both
drive and control power are connected.

Overcurrent
occurred.

Motor intermittently
drew more than its
rated level of current.
Does not cease motion.

Consider making motion less abrupt with
softer tuning parameters or acceleration
profiles.
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Troubleshooting

Issue

Cause

Solution

Excessive tem-
perature fault.

Motor has exceeded
temperature limit of
85°C. Motor will remain
unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient tem-
perature is too high. Consider adding heat
sinks or forced air cooling to the system.

Excessive position
error.

The motor's com-
manded position and
actual position differ by
more than the user-sup-
plied error limit.

Increase error limit, decrease load or
make movement less aggressive.

Historical pos-
itive/negative hard-
ware limit faults.

A limit switch was
tripped in the past.

Clear errors with the ZS command.

Motor does not have
limit switches attached.

Configure the motor to be used without
limit switches by setting their inputs as
general use.

Programming and SMI Issues

Several commands
not recognized during
compiling.

Compiler default firm-
ware version set incor-
rectly.

Use the Compiler default firmware ver-
sion option in the SMI software Compile
menu to select a default firmware version
closest to the motor's firmware version.
In the SMI software, view the motor's
firmware version by right-clicking the
motor and selecting Properties.
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Class 6 M-Style Connector Pinouts

Class 6 M-Style Connector Pinouts

The following table shows the pinouts for the connectors on the Class 6 M-style SmartMotors.

A OON -

HON -

(63}

©OoO~NOO O~ WN =

- a a
N = O

B OON -

24V 1/0

Control Power In

Chassis

Control, Com, I/O and Amplifier Ground
Amplifier Power In

Control, Com, I/0O and Amp Ground
RS-485 B, Comch. 0

RS-485 A, Com ch. 0

Encoder A+ Input/Output

Encoder B- Input/Output
Encoder A- Input/Output

+5V Out
Encoder B+ Input/Output

INO GP Input, Digital or Analog

IN1 GP Input, Digital or Analog
IN2/Pos Limit or GP, Digital or Analog
IN3/Neg Limit or GP, Digital or Analog
IN4 GP or Ext. Enc. Index Capture
IN5 GP or Int. Enc. Index Capture
IN6 GP, G Cmnd or Homing Input
IN7-DRVEN, Digital

OUTS, Digital - Brake or GP Output
OUTY9, NOFAULT, Digital Output

+24 VDC Out

Ground Common

EtherCAT / PROFINET

+TX +TD
+RX +RD
-TX -TD

-RX -RD

+24V (£20%), 32V Max

Common Ground
+24V Min, 48V Max

Common Ground

115.2 KBaud Max

115.2 KBaud Max

1.5 MHz Max as Encoder
or Step Input

1.5 MHz Max as Encoder
or Direction Input

1.5 MHz Max as Encoder
or Step Input

250 mA Max

1.5 MHz Max as Encoder
or Direction Input

T.B.D.

T.B.D.

T.B.D.

T.B.D.

T.B.D.

T.B.D.

T.B.D.

T.B.D.

250 mAmps Max
250 mAmps Max
12.5V Min, 23V Max Load
Common Ground

10/100BASE-T
EtherCAT=100BASE-TX

Communications

Industrial EtherNet

Power Input

Also supplies /0

Unisolated
Powers Amplifier Only

Unisolated

Configurable as Encoder
Output
Configurable as Encoder
Output
Configurable as Encoder
Output

Configurable as Encoder
Output

For Inputs:

Low Lvl Thid: 3.6V Max
High Lvl Thid: 5.0V Min

Inp. Hysteresis: 1.0V Min
Anlg Inp Scale: 24V FS 1%

For Outputs: Do not exceed
500 mAmps combined

Unisolated

Input (L), Output (R)

M16 4-Pin Male
1 4

© O
© Q

2 3

M12 8-Pin
Female End View

M12 12-Pin
Female End View

CAUTION: Exceeding 32 VDC
into control power on any of
the +24V pins may cause
immediate damage to the
internal electronics.
Exceeding a sustained voltage
of 48V to pin 4 of the P1 Power
Input may cause immediate
damage to the internal
electronics.

Exceeding these voltage limits
will void the warranty.
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